
CELL Help Index

The help of CELL includes such commands as follows:
Command

File Menu Open¡¢save¡¢print or send file.
Edit Menu Edit cell,    including copy¡¢paste¡¢clear operations.
View menu Set CELL view.
Table menu Set cell’s property.
Sheet menu Implement operation to page including insert¡¢delete¡¢perspective and so 

on.
Data menu Deal with sheet data processing .
Window menu Set window cascade or tile style.
Help menu Provide the help using CELL.



File menu commands

The File menu offers the following commands:

New Creates a new document.
Open Opens an existing document.
Close Closes an opened document.
Save Saves an opened document using the same file name.
Save As Saves an opened document to a specified file name.
Read Text 
File

Open text style files.

Query 
Database

Open files of listed type.

Output Excel 
File

Save file in Excel file style.

Output Text 
File

Save file in text file style.

Output 
HTML File

Save file in HTML file style.

Join File Join multiple files to a file.
Split File Split a file into multiple files.
Page Set Set page’s header and footnote and margin.
Print Set Set printer.
Print Preview Display document on screen in the type to be printed.
Print Print a document.
Point to Point Select a printer and connect to printer.
Send Use e-mail to send current document.
Exit Quit CELL.
 Edit menu commands

The Edit menu offers the following commands:

Undo Reverse previous editing operation.
Redo Cancel current undo operation.
Cut Deletes data from the document and moves it to the clipboard.
Copy Copies data from the document to the clipboard.
Paste Pastes data from the clipboard into the document.
Paste with the 
same size

At the current position insert clipboard contents, replace current destination cell’s contents.

Find Find specified character, and select the first cell contains this character.
Find Next Find next character that conforms to the find condition.
Replace Find and replace the specified character or value in current document.
Locate Scroll page and select the specified cell.
Select All Select all the cells in specified page.
Remove Remove the contents of specified cell.
Fill Fill cell.
Fill vert Fill specified areas’ content into corresponding locations of each page.
Fill formula 
serial

Using referred quoting relation,    copy top-left corner cell content of specified area into other 
cells of specified area.

Option Set page’s default size.



View menu commands

The View menu offers the following commands:
Tool bar Shows or hides the toolbar.
Col Row Label Show or hide Col row label.
Background Specify the style of selected area.
Fixed pane Set /Cancel the top-left cell of current cell frozen row and column.
Status Bar Shows or hides the status bar.
Page Label Show or hide page label.
Row Label Show or hide row label.
Col Label Show or hide column label.
Horizontal 
Scroll bar

Show or hide horizontal scroll bar.

Vertical 
Scrollbar

Show or hide vertical scroll bar.

 



Table menu commands
Cell Set cell style¡¢alignment¡¢font color¡¢value format¡¢boarder¡¢input 

control.
Size Set total number of rows and columns of cell.
Row Chang total number of row and row height.
Col Chang total number of column and column width.
Insert Picture Set the directory and file name of inserted picture.
Draw 
Line/Remove Line

Set the line style to be drew.

Join Cell Combine the selected area a cell.

Unjoin Cell Separate the combined cell discrete cells.
Fit Row Height Change the row height to a suitable height to display the content of 

selected cell.
Fit Col Width Change the column width to a suitable width to display the content of 

selected cell.



Sheet menu commands
Page Label Page Label to specified page.
Insert Page Insert specified amount of pages before current page.
Delete Page Delete the page of specified page number.
Append Page Append specified amount of pages to the last page.
Output Page Output several pages into a file.
Simple Sum Use the current page as a template, generate a summary page, and 

sum the selected cells of current page.
Area Sum Sum the selected area of current page.
Area Perspective Do the perspective in selected area, perspective sheet 1 shows the 

two dimension relation, perspective 2 shows the 3 dimension relation.
Sort Page Change the order of pages,    to be ascending or descending order.
Query in Pages Query specified expression or value in pages.
Query in Books Query specified expression or value in books.
Lock Setting Set cell to be read only or none read.
Lock Set current page with read only or none read lock.
Unlock Unlock none read lock, then file can be read. Unlock read only lock, 

file can be read and changed.



Data menu command

Input Formula Set formula to selected cell.
Formula 
Option

Set expression option to be mathematical expression or logical expression, 
show option to be formula value or formula expression.

Set Sum 
Formula

When select an area, after set sum formula, sum the corresponding area of 
all pages.

Set 3d Expand 
Formula

Expand a 3d area (same location in many pages) data at current page by 
set formula.

Reference 
Audit 

Reference audit including Reference Cell and Subordinative Cell.

Formula List Display the relation of formula list set, such as page label, and the row and 
column number of each formula and its value.

Recalculate Recalculate all formula, update their values,    includes Recalculate Pageand 
Recalculate Form

Data Rotate Rotate the selected area clockwise.
Chart Guide Select data and make a chart.
Sort Area Sort the value of selected area.
Classify Sum Classify sum selected area. Sum type includes total¡¢count¡¢average¡¢max 

value and minimum value.
Query Area Query in specified area.
Condition 
Evaluate
Round 
Balance
Data Audit



Window menu commands

The Window menu offers the following commands, which enable you to arrange multiple views of multiple 
documents in the application window:

Cascade Arranges windows in an overlapped fashion.
Tile Arranges windows in non-overlapped tiles.
Arrange Icons Arranges icons of closed windows.
Window 1, 2, ... Goes to specified window.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this application: 

Help 
Topics

Offers you an index to topics on which you can get help.

About Displays the version number of this application.



Input 

Dynamically expand edit area

When the width of inputted content is beyond the cell’s width,    if in Common Toolbar ”expand edit area” 
button is in pressed down state£¨ default state£©, CELL will expand edit area to display more 
contents£»if ”expand edit area” button is in up state, inputted content will scroll to be displayed.

Intelligent input guide

When enter into cell edit state, if there is data in cell, cursor will locate after all the cell’s data. Unless 
delete previously inputted content, or new inputted content will not overwrite previous content.

You can use up¡¢down¡¢left¡¢right for arrow key to move cursor into a neighbor cell and enter into edit 
state. Tab key or Shift+Tab key can move cursor to left or right and enter into edit state.

You can use Return key to move cursor into a neighbor cell and enter into edit state,    default is to right 
cell. When use cursor to change direction, you can use up¡¢down¡¢left¡¢right four cursor key¡¢Tab key or 
Shift+Tab key. Once change direction use one of these six keys, and next use return key to move cursor, 
cursor will follow the direction of these six key indicated, until you use one of these six keys to change 
direction. Thus, you can control cursor direction freely using return key and several direction key. When 
there are bulk data to be inputted, this method is efficient.

Random input 

If there the data in CELL are irregular, you can use random input method. It is:    mouse left key click none 
current cell(or it will enter into drag and drop state) and hold it, left hand use keyboard to input data. 
When finish inputting, move mouse to next cell to be inputted(left key is still held), then left hand input 
data. When mouse move to margin of cell, cell will scroll. This method is called random input method.

Above input method, only need some practice,    and you will master the skill,    then you will input data 
more efficient. It will save your energy.

In addition, in the cell property dialog, you can set the property of the inputted content,    including 
minimum value and max value¡¢automatically change the inputted letter into uppercase and so on.



Cell Scroll

Horizontal scroll bar: drag this scrollbar window can move in horizontal direction. 

Vertical scroll bar: drag this scrollbar window can move in vertical direction.

Bottom-right scrollbar: This button locates in the bottom-right of window.£¨That is the intersection of 
horizontal scroll bar and vertical scroll bar. Only when horizontal scroll bar and vertical scroll bar are 
displayed together, this button comes into view.£©With mouse left key held on this scrollbar button, you 
can move window bottom right. Right key is used to change direction. While moving, free left key, click 
right key , then left key holds this scrollbar button, window moves up left.



Formula and Expression

Cell: In CELL”column label letter row label number “ denote a cell, for example column label is”5E” , row 
label is”7” , it indicate a cell “E7” .

Cell has two types:number type and character type. The default colors to differentiate them are blue and 
black. The cell has formula is marked by brown.

Area: Rectangle area is denoted by”top left cell: bottom right cell” , for example: area covers cell 
A3¡¢A4¡¢A5¡¢B3¡¢B4¡¢B5 is denoted as”A3:B5” .

Formula can only be set to cell not to area.

Input formula: Press key “=“ in a cell ¡¢click”input formula” button or use input formula    command(Data 
menu) to invoke input formula dialog box. In dialog box,    input expression in Formula area and you can 
get the help of how to use the function.

When set similar formula to a area, you can use Fill formula serial    command(Edit menu).

All formula results can be refreshed by using Formula recalculate    command(Data menu).

Expression: Cells of number style allow mathematical and logical calculating. Cells of character style 
allow comparison and addition calculating.

There must be space between logical character and other characters.

Use Formula     command(Data menu),    you can set the interpretation domain of expression by system.



New command (File menu)

Use this command to create a new document in CELL.    Select the template you want to create in the 
Template dialog box. 

You can add template yourself, find cell.exe’s directory first, there is a directory named template here, 
place your cll file to the template directory, next time you create new file can use this cll file as a template. 
You can create sub directorys in template directory, then the template dialog will show a tree to select.

You can open an existing document with the Open command.

Shortcuts

Toolbar:
Keys: CTRL+N



Open command (File menu)

Use this command to open an existing document in a new window.    You can open multiple documents at 
once.    Use the Window menu to switch among the multiple open documents.    See Window 1, 2, ... 
command.

You can create new documents with the New command.

Shortcuts

Toolbar:
Keys: CTRL+O



File Open dialog box

The following options allow you to specify which file to open:

File Name
Type or select the filename you want to open.    This box lists files with the extension you select in the 
List Files of Type box. 

List Files of Type
Select the type of file you want to open:

Drives
Select the drive in which CELL stores the file that you want to open. 

Directories
Select the directory in which CELL stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Close command (File menu)

Use this command to close all windows containing the active document.    CELL suggests that you save 
changes to your document before you close it.    If you close a document without saving, you lose all 
changes made since the last time you saved it.    Before closing an untitled document, CELL displays the 
Save As dialog box and suggests that you name and save the document.

You can also close a document by using the Close icon on the document's window, as shown below:



Save command (File menu)

Use this command to save the active document to its current name and directory.    When you save a 
document for the first time, CELL displays the Save As dialog box so you can name your document.    If 
you want to change the name and directory of an existing document before you save it, choose the Save 
As command.

Shortcuts

Toolbar:
Keys: CTRL+S



Save As command (File menu)

Use this command to save and name the active document.    CELL displays the Save As dialog box so 
you can name your document. 

To save a document with its existing name and directory, use the Save command.



Read text file (File menu)

File name: input the directory and file name of which you want read.
Text file format: Set the format of how to separate cells.
Limit columns : Set whether set CELL number of columns , if, set the max    number of columns .
Preview Text : show text file’s content .
Preview Form: preview CELL file content after conversion.



Query database (File menu)

Source style: Select database style of which will be read in. CELL can open such styles and versions of 
database as: Accessfile(*.mdb)¡¢dBASEfile (*.dbf)¡¢Paradoxfile(*.db)¡¢Btrievefile(*.ddf)¡¢FoxProfile(*.dbf)
¡¢Lotus 1-2-3file(*.wks¡¢*.wk1¡¢*.wk3¡¢*.wk4)¡¢text file(*.txt)¡¢ODBCdata source    ¡¢Excelfile(*.xls).

Source database: input database directory and name , or you can use the right” ...” button to 
display”open file” dialog box, and select the source database.

Query table: When use such multiple table database as Access file¡¢Excel file, select the sheet to be 
opened.

User defined query: You can use SQL language’s query sentence SELECT in database to select data.

Open button: After set” source database style”    and “ source    database name “ , use open button to 
open a database. When use Access file¡¢Excel file such multiple table database, in”query raw data list” 
list,    there is name list have all table name.

Use close button close opened database.

Query button: Press this button,    query result is displayed in “data area” .

Data area: Show query result .

Print button: Print what “data area” shown query result .

Print preview button: Preview what “data area” shown query result .

Copy button: Copy what “data area” shown into clipboard, so you can paste them into CELL.





Output Excel file(File menu)

Save selected pages or area in an Excel style file.

Object file: input file name converted into Excel format file.
Output content : Set conversion mode, including area¡¢ current page or whole CELL conversion.
Convert begin: Start to convert.



Output text file command(File menu)

Text file format : Set the replace mode of CELL converted into text style you can separate with Tab 
key¡¢space or comma.
File name: Input text file name of the converted text file.



Output HTML file command(File menu)

Save CELL file in HTML file format.



Join file command(File menu)

Object file: Click omission button, you can save target file name into specified location, click bottom left 
checkbox, source file is the corresponding page page label.

Source file name list: Click add button, you can select source files to be joined, click again, you can 
select another file. Thus you can select multiple source file.

Add: click it, you can open source file from list dialog box, select what you needed source file.

Delete: When select multiple or wrong source file, click this button, you can delete source file.

Join: After select all source files needs joining,    click this button to start joining file.



Split file command(File menu)

Source name: click the right omission button, open source file to be split.

Save to directory: Specified directory the source file to be split.

Split file name list: Show the new filename of source file split.

Create name: Click this button, you can open a dialog box. In this dialog box, you can name the new file, 
and save them to specified directory.

Add: click this button, you can add a new file£¨That is source file split into two or more new files£©.

Delete: click this button, you can delete unneeded or wrong named new files.

Start : click this button, start splitting.

Pages number of every file: Adjust the right spin button, you can set the page number of each new file.

Use page Label as file name: Select left checkbox,    the new files are named source file page label.



Page Set command(File menu)

Set the outlook of CELL. You can set Work sheet¡¢Head/Foot  and Edge/scale.



Work sheet

Print range: Set the area of page to be printed.



Edge/scale

Edge/scale: Set”top” ¡¢”bottom” ¡¢”left”    and “right” margin of the paper to be printed.



Head/Foot

To show or print Header in top left corner of page, you need to input the text in “Header” edit box of 
“Header” .

To show or print Header in top center corner of page,    you need to input the text in “center”    edit box 
of”Header” .

To show or print Header in top right corner of page,    you need to input the text in “right” edit box of 
“Header” .

To show or print Header in bottom left corner of page,    you need to input the text in “left” edit box of 
“Header” .

To show or print Header in bottom center corner of page,    you need to input the text in “center” edit box 
of “Header” .

To show or print Header in bottom right corner of page,    you need to input the text in “right” edit box of 
“Header” .

“Page number” button: Insert Page number of Header or Footnotes.

“data” button: insert current data.

“time” button: insert current time.

Font : Set font ¡¢style¡¢size and color of the header and footnote.



Print Set
Set the printer name, page source, page size and printer property.



Print preview command(File menu)

Show print outcome of all pages.

You can use the most common print preview toolbar icon to preview page.

Print button: Click this button,    use print dialog box print current previewed content .

Print Set button: Click this button,    display print set dialog box. Use”property” button you can set page 
size and direction.

Page Set button: Display page set dialog box.

Close button: Close print preview window .

“Resize control” box: Zoom out or zoom in displayed page, the scale is between 10%—200%. You can 
set the zoom ration with no change to the outcome of printing.

 Vertical scrollbar: Up scrollbar scroll in one page, down scrollbar scroll between pages.



Print command(File menu)

Use print dialog box to print current document. Use top right corner question mark to click each item of 
dialog box to get its help.

You can use the print icon of Common Toolbar to display print dialog box.



Point to Point command(File menu)
Transmit file using hyperterminal.



Send command(File menu)

New Address: Input new receiver’s address here,    then press Add button add it in.

Receiver Address:

Add: Click this button and you will add currently inputted receiver address into receiver address list.

Send: Begin to send.



Recent file list command(File menu)

 List recent opened files. Click one file, then CELL opens this file.



Exit command(File menu)

Use this command to end your CELL session.    You can also use the Close command on the application 
Control menu.    CELL prompts you to save documents with unsaved changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to save:

File Name
Type a new filename to save a document with a different name.    A filename can contain up to eight 
characters and an extension of up to three characters.    CELL adds the extension you specify in the 
Save File As Type box.

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.

Network...
Choose this button to connect to a network location,    assigning it a new drive letter. 



Undo(Edit menu)

Use this command to reverse the last editing action,    if possible.      The name of the command changes, 
depending on what the last action was.    The Undo command changes to Can't Undo on the menu if you 
cannot reverse your last action.

Shortcuts

Toolbar:
Keys: CTRL+Z or

ALT-BACKSPACE



Redo command (Edit menu)

Use this command to reverse the last undoing action.



Cut command (Edit menu)

Use this command to remove the currently selected data from the document and put it on the clipboard.    
This command is unavailable if there is no data currently selected.

Cutting data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+X



Copy command (Edit menu)

Use this command to copy selected data onto the clipboard.    This command is unavailable if there is no 
data currently selected.

Copying data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+C



Paste command (Edit menu)

Use this command to insert a copy of the clipboard contents at the insertion point.    This command is 
unavailable if the clipboard is empty.

Shortcuts

Toolbar:
Keys: CTRL+V



Same size paste command(Edit menu)

Use this command insert a copy of clipboard’s content into inserted cells. If clipboard
is empty, this command is useless.



Find command(Edit menu)

Find specified character in selected cells or page, and select the first cell contains these characters.



Find Next command(Edit menu)

Find next character meet with search condition.



Replace command(Edit menu)

Find and replace specified character or number in current document.



Locate command(Edit menu)

Scroll page and focus on found cell.

Cell: Target cell. to be located.

Page Number: Set the page number of the cell to be located .



Select All command(Edit menu)

Select all cells in page.

You can also use the select all button at the intersection between row label and column label to select all 
cells.



Remove command(Edit menu)

Remove content and format of cells. You can use such command as follows: Remove Formula¡¢Remove 
Chart¡¢Remove Text¡¢Remove Format¡¢Remove All



Remove Formula

Remove Formula: Remove formula of selected cells, content and format of the cells stay unchanged.



Remove Chart

Remove Chart: Remove chart of selected cells.



Remove Text

Remove Text: Remove content of selected cells., cells’ format stay unchanged.



Remove Format

Remove Format: Remove format of selected cells, cells’ content stay unchanged.



Remove All

Remove All: Remove all content and format of selected cells .



Fill command(Edit menu)

Fill mode includes Fill down¡¢Fill right¡¢Fill up¡¢Fill left¡¢Fill same¡¢diff Fill¡¢Ratio Fill , Fill formula serial



Fill down

Fill down: Copy content of the top cell in the selected rectangle area to all the cells below in the selected 
rectangle area.



Fill right

Fill right: Copy content of the leftmost cell in the selected rectangle area to all the right cells in the 
selected rectangle area.



Fill up

Fill up: Copy content of the bottom cell in the selected rectangle area to all the up cells in the selected 
rectangle area.



Fill left

Fill left: Copy content of the rightmost cell in the selected rectangle area to all the left cells in the selected 
rectangle area.



Fill same

Fill same: Copy content of current cell to all the cells in selected areas (Includes multiple areas, that is 
irregular area).

 



diff Fill

diff Fill: Set the top left cell of selected rectangle area as start number, the difference of the first two cell’s 
number in top left as step,    fill other cells in selected area in ascending order.

 



Ratio Fill

Ratio Fill: Set the top left cell of selected rectangle area as start number, the ratio of the first two cell’s 
number in top left as step,    fill other cells in selected area in ratio order.



Serial Fill
Fill cell use row first then column or column first, then row mode. And you can edit seial.

 



Fill vert command(Edit menu)

Fill content in multiple pages. That is,    fill the contents of selected area to the corresponding area of each 
page.

 



Fill formula serial command(Edit menu)

Copy the formula of top left cell in selected area to other selected cells,    using conditional reference 
relation. If there is no formula in top leftmost cell,    display input formula dialog box. Input formula,    then 
fill formula in selected area.



Option command(Edit menu)

 



Toolbar command(View menu)

Show toolbar: Show or hide toolbar. Toolbar includesCommon Toolbar¡¢Format Toolbar and Assist 
Toolbar If some toolbar is to be displayed, check its menu item.

Icon size: Set icon size.

 



Common Toolbar 

click to

Open a new document.

Open an existing document.    CELL displays the Open dialog box,    in which you can locate and 
open the desired file.

Save the active document or template with its current name.    If you have not named the 
document,    CELL displays the Save As dialog box.

Print the active document.

Preview the printing outcome of active page.

Remove selected data from the document and stores it on the clipboard.

Copy the selection to the clipboard.

Insert the contents of the clipboard at the insertion point.

To expand dynamically the edit area to display more contents.

Input formula to cell.

Rank the specified column or row in ascending order. If there are multiple rows or columns 
selected, display rank dialog box.

Rank the specified column or row in descending order. If there are multiple rows or columns 
selected, display rank dialog box.

Set the selected column to the most fitful width.

Set the selected row to the most fitful height.

Split the selected cell into two horizontal cells.

Split the selected cell into two vertical cells.

Combine the rectangle area into a join cell.



Separate the join cell into individual cells.

Combine the rectangle area into line-joined cells.

Combine the rectangle area into column-joined cells.
 



Format Toolbar

Set the width of lines to be drawn. “blank” means removing lines.

Draw rectangle lines to selected area.

Draw boarder lines around the selected rectangle area.

Draw top line to each cell in selected rectangle area.

Draw bottom line to each cell in selected rectangle area.

Draw left line to each cell in selected rectangle area.

Draw right line to each cell in selected rectangle area.

Draw slash line in rectangle area from right to left.

Draw slash line in rectangle area from left to right.

 



Assist Toolbar

Set the font style of selected area.

Set the font size of selected area.

Set the font of selected area bold. If it is slash font,    then cancel it.

Set the font of selected area slash. If it is slash font,    then cancel it.

Set the font of selected area with underline. If it is slash font,    then cancel it.

Set the selected area linefeed automatically.

Set text¡¢number left alignment.

Set text¡¢number horizontal center alignment.

Set text¡¢number right alignment.

Set text¡¢number top alignment.

Set text¡¢number vertical center alignment.

Set text¡¢number bottom alignment.

 



Col row label command(View menu)

Show Col row label: Set whether show or hide Col row label.

Label type: Set row and column label outface invax or concave 3 dimension or flat.

 



Background command(View menu)

Set background style of workspace.
Default background: Set the line style of cells in workspace.

User defined background: Only when “user defined” is checked,    this function is valid. You can set 
whether there is lines,    and the width of lines of row and column and background color.

 



Fixed pane (View menu)

Set /Cancel the top left columns and rows of active cell frozen.
 



Status bar command(View menu)

Set whether to show or hide status bar at the bottom of window. Status bar shows the selected menu item 
or pressed down toolbar button, or the lock state of keyboard, and the next operation. If status bar is 
displayed, there its menu item will be checked.
 



Page Label command(View menu)

Show or hide page label.
 



Row Label command(View menu)

 Show or hide row label.



Col label command(View menu)

Show or hide column label.
 



Horizontal Scrollbar command(View menu)

Show or hide horizontal scroll bar.

 



Vertical Scrollbar command(View menu)

Show or hide vertical scroll bar.

 



Cell command(Table menu)

Cell command can set CELL’s Type¡¢Align¡¢Font¡¢Value Style¡¢Frame¡¢Input control and so on.

 



Type
Set cell’s style.
Cell style: 

Normal: Includes character style and number style.

Button: Set cell button style, and the button can trigger a procedure.

Radio button: Set cell radio button type, and the selected value is set the value of the cell.

Drop list: Set cell drop drown box, you can select a value from the drop down list box as cell’s value.

Check box: Set cell check box button, if the check box is checked,    cell’s value is 1, otherwise it is 0.

Spin: If there is common spin button to the right of cell, when pressed it there is a group of already set 
data displayed, which is the value of cell.

Step spin: If there is same step spin button to the right of cell, when pressed it there is a group of already 
set same step array data displayed, which is the value of cell.

Chart: Set cell chart style.

You can also use the chart icon in toolbar to set cell chart style.

Drop window : There is an area in this page whose data is referred when inputting. The value of selected 
cell becomes the value of this cell.

 



Align
Set text alignment style.
Align: It is the content alignment mode of cell, including horizontal mode and vertical mode.

You can use the icons in Assist Toolbar to set cells content alignment mode .

Text: 

Single line: If column width is not enough for displaying all the content of cells, the content beyond the 
column width is not displayed.

Word break: For character type cell, when column width is not enough for displaying all content of the 
cell, it will be shown in multiple lines.

You can use the multiple lines show icon in Assist Toolbar to set this property.

Show hint: When column width is not enough for displaying all content of cell, the mark “...” indicates it.

Cell shape: 

Normal: Cell is displayed with default color and flat surface.

Raised: Cell is displayed with raised mode.

Recessed: Cell is displayed with recessed mode.



Font

Set font name¡¢font style¡¢font size¡¢font color and background color of characters in cell.

You can use the icons in Assist Toolbar to set font ¡¢property of font¡¢size.



Value Style 
Set Value style in CELL.
As string: Number style is changed into character style.

Comma: In number style cell, whether to separate three digits with comma separator.

percent: In number style cell, whether to display the cell in “Cent”    mode.

Scientific: In number style cell, whether to display the cell in science mark mode.

minus: In number style cell, whether to display negative in red color.

Currency: In number style cell, whether to display the number of cell with a currency mark.

BOOL: Set cell’s value 0 or 1 to mark the logical result .

Decimals: In number style cell, set the number of the decimal digits.

Unit: In number style cell, cell’s content displayed equal to result of real content dividing the unit.



Frame
Set boarder’s type and color.
Set CELL’s boarder’s line type and line color.

You can use icons in Format Toolbar to set boarder’s property.



Input control

Set CELL’s style.
Content control: 

Text: Set the max allowed number of characters.

Value: Whether set the range of input number its minimum value and max value.

Digit : Cell only accepts number , and rejects other contents.

Letter : Cell only accepts letter , and rejects other contents.

Data: Set cell’s data format to be shown in .

Time: Set cell’s time format to be shown in .

Control mask: Input or select self defined control string to display string.

Case control: 

Convert the inputted letter into uppercase or lowercase .



 Size command(Table menu)

Set CELL’s total number of rows and total number of columns .



 Row command(Table menu)

Change row’s total number and row’s height. Command includes Insert row¡¢Delete row¡¢Append 
row¡¢Row height.



Insert row

Insert row: Insert a number of rows before current row.



Delete row

Delete row: Delete specified row.



Append row

Append row: Append a number of lines following the page bottom.



Row height

Row height: Specified height of specified row. Row height ranges from 0-800



Col command(Table menu)

Change column’s total number and column’s height. Command includes Insert column¡¢Delete 
column¡¢Append column¡¢Column width.



Insert column

Insert column: Insert a number of column before the active column.



Delete column

Delete column: Delete specified column.



Append column

Append column: Append a number of columns at the end of the page.



Column width

Column width: Set the specified column’s column width, its range is 0-800.



Insert Picture£¨Table menu£©: 

Set the directory and file name of the picture to be inserted.



Draw Line/Remove Line£¨Table menu£©: 

Set line style in which to be drawn.



Join Cell command£¨Table menu£©: 

Combine the cells of selected area a cell.

You can also use join cell icon in Common Toolbar, or use row join cell icon and column join cell icon 
combine the selected area a cell.

You can also drag cell’s four corner to join cell.



Unjoin Cell command£¨Table menu£©: 

Separate join cell into individual cells.



Fit Row Height command£¨Table menu£©: 

Set row height of selected area to display all the content in cells. If you change cell’s content,    you 
should adjust row height again.

You can use the fit row height icon in Common Toolbar to fulfill this operation.



Fit Col Width command£¨Table menu£©: 

Set column width of selected area to display all the content in cells. If you change cell’s content,    you 
should adjust column width again.

You can use the fit column width icon in Common Toolbar to fulfill this operation.



Page Label command(Sheet menu): 
Set page a page label.



Insert Page command(Sheet menu): 

Insert a number of pages before the active page.

Blank: Press this button, insert a number of blank pages.

Use current page as template: Press down this button, insert a number of pages whose contents are 
the same as template’s.

Source file: Press down this button, then press down omission button, you can insert some page of other 
files.



Delete Page command(Sheet menu): 

Delete the page of specified page number.



Append Page command(Sheet menu): 

Append a number of pages follow the last page.



Output Page command(Sheet menu): 

Save several pages to a file.



Simple Sum command(Sheet menu): 

Use the active page as template, generate a sum page. Sum the content in selected area in sum page.



Area Sum command(Sheet menu): 

Sum the selected area in the active page. Horizontal sum is listed in prospective page1 , vertical sum is 
listed in prospective page2, following picture is a sample:



Area Perspective command(Sheet menu): 

Display the results of prospective to selected area, prospective page1 is the result of horizontal sum, 
prospective page2 is the result of vertical sum.



Sort Page (Sheet menu): 

Sort pages,    there are ascending mode and descending mode .



Query in Pages(Sheet menu): 

Query object : Set the area to be queried, for example: A1: G6.

Query type: Set one of the six type: list¡¢ sum ¡¢count ¡¢average value¡¢max value and minimum value.

Page select expression: Used to sort pages, for example¡Ã A5 > 4, means that if one page’s A5 is 
greater than 4, the page will be one page of page sorting expression. Function looppage() and this() are 
used more frequently. Function looppage() returns pages selected, for example looppage() >=1 AND 
looppage() <= 3,    then page1, 2, 3 are selected. Function this() returns the active page’s cells, for 
example    A5 + this( A6 ) > 4 , when sorting, A5 is the every page’s A5, and this( A6 ) refers current 
page’s A6.

Query: Click this button, starts querying.

Prospective: Click this button, opens area prospective dialog box. Please refer area prospective.

Append Page: Click this button, appends a blank page.

Delete Page: Click this button, deletes the current page.

Copy: Copy selected content to clipboard.





Query in Books(Sheet menu): 
Object file name: Click the right button to open target file.

Query area: Input the area to be queried, for example: a1:g6.

Page select expression: Used to sort pages, for example¡Ã A5 > 4, means that if one page’s A5 is 
greater than 4, the page will be one page of page sorting expression. Function looppage() and this() are 
used more frequently. Function looppage() returns pages selected, for example looppage() >=1 AND 
looppage() <= 3,    then page1, 2, 3 are selected. Function this() returns the active page’s cells, for 
example    A5 + this( A6 ) > 4 , when sorting, A5 is the every page’s A5, and this( A6 ) refers current 
page’s A6.

Query type: There are six query styles: list¡¢ sum    ¡¢count ¡¢average value¡¢max value and minimum 
value.

Query: Click this button, starts querying.

View Object: Click this button, open prospective target book.

Prospective: Click this button, prospective the active book.

Append Page: Click this button, appends a blank page.

Delete Page: Click this button, deletes the current page.

Copy: Copy selected content to clipboard.





Lock Setting (Sheet menu): 

Set the lock read only or none read lock.



Lock(Sheet menu): 

After successfully set read only or none read lock or both, then use page lock command, you can set a 
read only or none read lock to current page. When set a read only lock to a page,    file can only be read 
without editing. When set an none read lock to current page, file is invisible£¨Neither can be read,    nor 
can be edited.£©.



Unlock(Sheet menu): 
Only after successfully set read only lock or none read lock to a page, you can unlock a page. Unlock 
none read lock, file can be read£»unlock read only lock, file can be edited£¨You can read it and edit it.£©.



Input formula command(Data menu): 

Set formula to a cell. Please refer formula and expression.

You can also use “=“ key or click the input formula button on Common Toolbar to input formula.

Caution: Formula can not be quoted recursively.



Formula Option command(Data menu): 

Set the parse option arithmetic expression or logical expression,    and set show option show result or 
show formula text.



Set sum formula(Data menu): 

Select an area, set sum formula, it will sum all the corresponding area of all the previous pages.



Set 3d expand formula(Data menu): 

Expand a 3d area (same location in many pages) data at current page by set formula.
Example: You want get value of every pages’ A3 cell, and list it in current page, you want to trace these 
cells’ change, so you have to set formula. Use this command to set a batch of formulas.

Note: Formulas referenced other page cell’s value can’t recalculate automatically, you can recalculate it 
by using Recalculate Command (Data menu). 



Reference Audit(Data menu): 

Reference audit includes Reference cell and Subordinative cell.



Reference cell

List those cells that refer the active cell.



Subordinative cell

List those cells that the active cell refers.



Formula List(Data menu): 

Show the corresponding relation of set formula, including page label, and row and column label of each 
formula and the result of each formula.



Recalculate command(Data menu): 

Recalculate all formula, refresh all calculation result,    including Recalculate page and Recalculate book.

Notes: Formulas referenced other page cell’s value can’t recalculate automatically, you can recalculate 
all formulas in a book it by using this Command. 



Recalculate page 

Recalculate all formula of current page.

Notes: Formulas referenced other page cell’s value can’t recalculate automatically, you can recalculate 
all formulas in current page by using Recalculate Command (Data menu). 



Recalculate form

Recalculate all formula of the book.



Data Rotate command(Data menu): 

Select an area, set data rotate, then open dialog box, click rotate button, you can rotate the data of 
selected area clockwise ,    90 degree one time.

Col Reverse: Click this button,    rotate the selected area in horizontal direction.

Row Reverse: Click this button,    rotate the selected area in vertical direction.

Reset: Click this button,    cancel what rotate button¡¢column direction button and row direction button 
have done, and recover what the selected area has been.

  



Chart Guide command(data menu): 

Select the chart mode.
Source data: Select the area of the source data for drawing chart and making chart’s legend.

Load: Click this button to fill data into data area list.

Axis: Set the choice to draw a chart by row or by column.

Data area: Display the data list for drawing chart. You can edit the data here while the original data are 
not changed. The edited cell will not display the original quotation in “quotation relation” lable.

Column axis¡¢row axis: While making chart according to rows, there can be a row displayed as the 
column axis data description. In the dialog box the description row is marked with “column axis” to its 
right, other rows are the data source of the chart and to their right there is a description “row axis”.

While making chart according to columns, there can be a column displayed as the column axis data 
description. In the dialog box the description column is marked with “column axis” to its right, other 
columns are the data source of the chart and to their right there is a description “column axis”.

Description column¡¢data column: While making chart according to rows, there can be a column 
displayed as the legend text. In the dialog box the description column is marked with “description column” 
in its bottom, other columns are the data source of the chart and in their bottom there is a description 
“data column”.

While making chart according to columns, there can be a row displayed as the legend text. In the dialog 
box the description row is marked with “description column” in its right, other rows are the data source of 
the chart and in their right there is a description “data column”.

Chart data: This button is used to display the chart’s original data.

Reference relation: This button is used to display the reference relation of chart’s data.

Sample: Display the outlook of chart.

Title: It is on the top of chart.

Foot: It is at the bottom of chart to denote the chart.

X attribute: Set X axis even scale or not. When X axis is a number axis it valid.

Y title: On the left of Y axis,    it is displayed as the unit of Y axis or as the legend of Y axis.

Type: Set the type of chart. There are column chart¡¢polyline chart and dot chart.

Insert/delete row/column: Increase of decrease the data chart referred.

Refresh: When there is a change in chart’s setting, apply this button to refresh the outlook of chart.





Sort Area command(Data menu): 

Sort the number of selected area.



Classify Sum command(Data menu): 

Use this command to classify sum the selected area. Sum style includes five kinds of sum as follows: sum 
¡¢count ¡¢average value¡¢max value and minimum value.

Source area: Set the selected area. You can change its size freely,    then click source data button to 
refresh it.

Key col: Set a column as key value column. Other columns are text columns.

List type: There are five kinds of sum: sum ¡¢count ¡¢average value¡¢max value and minimum value.

Classify sum : After selecting sum style, then click classify sum button, you can do sum calculating using 
selected style.

Copy: In classify sum dialog box, copy all of the page of a selected area in the page to clipboard.

Delete col: Delete the column where cursor focuses on.

Delete row: Delete the row where cursor focuses on.

Append Page : Click this button,    it will add a new blank page at the end of this book.

Delete Page : Delete the page where cursor focuses on .

Source data page : Set the number of page where data come from.

Sum page C- sum    : Classify sum selected area with column B being key value. There are five kinds of 
sum: sum ¡¢count ¡¢average value¡¢max value and minimum value.





Query Area (Data menu): 

Query object : Input the area to be queried, for example: A1: G5.

Query type: There are six query styles: list¡¢ sum    ¡¢count ¡¢average value¡¢max value and minimum 
value.

Row select expression: Used to sort rows, for example¡Ã A5 > 4, means that if A5 is greater than 4, the 
row will be one row of area sorting expression. In the next row,    the expression is A6>4,    if it is true,    this 
row will also be one row of area sorting expression. Function looppage() and this() are used more 
frequently. Function looppage() returns rows selected, for example looppage() >=1 AND looppage() <= 3, 
then row1, 2, 3 are selected. Function this() returns the active page’s cells, for example    A5 + this( A6 ) > 
4 , when sorting, A5 will change, while this( A6 ) always returns A6. Using row sorting expression will get 
the same result as using database’s SELECT(WHERE) sentence.

Query: Click this button, start query.



Condition Evaluate command(Data menu): 



Round Balance command(Data menu): 



Data Audit command(Data menu): 



Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion. 



Tile command (Window menu)

Use this command to arrange multiple opened windows in a non-overlapped fashion.



Tile Horizontal command (Window menu)

Use this command to vertically arrange multiple opened windows in a non-overlapped fashion.



Window Arrange Icons Command

Use this command to arrange the icons for minimized windows at the bottom of the main window.    If 
there is an open document window at the bottom of the main window, then some or all of the icons may 
not be visible because they will be underneath this document window. 



1, 2, ... command (Window menu)

CELL displays a list of currently open document windows at the bottom of the Window menu.    A check 
mark appears in front of the document name of the active window.    Choose a document from this list to 
make its window active. 



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can jump to 
step-by-step instructions for using CELL and various types of reference information. 

Once you open Help, you can click the Contents button whenever you want to return to the opening 
screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of CELL.



Context Help command 

Use the Context Help command to obtain help on some portion of CELL.    When you choose the 
Toolbar's Context Help button, the mouse pointer will change to an arrow and question mark.    Then click 
somewhere in the CELL window, such as another Toolbar button.    The Help topic will be shown for the 
item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

The title bar is located along the top of a window.    It contains the name of the application and document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging their title 
bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button

Name of the application

Name of the document

Restore button



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside the scroll bars 
indicate your vertical and horizontal location in the document.    You can use the mouse to scroll to other 
parts of the document.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the arrow keys.

After the pointer changes to the four-headed arrow:

1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the 
border you want to move. 

2. Press a DIRECTION key to move the border.

3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or dialog box with 
the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the CELL window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window command (document Control menu)

Use this command to switch to the next open document window.    CELL determines which window is next 
according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (document Control menu)

Use this command to switch to the previous open document window.    CELL determines which window is 
previous according to the order in which you opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the document 
Control menu closes only one window at a time.    You can close all windows at once with the Close 
command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the <<YourType>> window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the Maximize or 
Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to or close an 
application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the following 
options:

Task List
Select the application you want to switch to or close.

Switch To
Makes the selected application active.

End Task
Closes the selected application.

Cancel
Closes the Task List box.

Cascade
Arranges open applications so they overlap and you can see each title bar.    This option does not 
affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not affect 
applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Edit document

In main window, you can do following things with mouse and keyboard:
1 Mouse Operation: 
      Sizing row height or column width    palce mouse in the edge of col&row label cell, press left button and 

drag.
      Join or unjoin cell    place mouse at the corner of current cell and press left button and drag.
      Selected                    in grid area press left button and drag.
      Unselected                Click any not selected cell.
      Drag and drop          move mouse to any selected cell, press left button and drag, press Control key to 

copy, otherwise will move the selected cells.
      Pop menu                  in main window, click right mouse button will show pop menu. 
2 Keyboard Operation: 
      input String or number    note: use Control+Enter to input a line break
      input formula                    press = key
      Delete cell text                  move to the cell and press Del key
      Selecte cell                        Control + -> or Shift + -> and so on.
      Move cell                            direction key

 
The help of CELL includes such commands as follows:
Command

File Menu Open¡¢save¡¢print or send file.
Edit Menu Edit cell,    including copy¡¢paste¡¢Remove operations.
View menu Set CELL view.
Cell menu Set cell’s property.
Page menu Implement operation to page including insert¡¢delete¡¢perspective and so 

on.
Data menu Deal with sheet data processing .
Window menu Set window cascade or tile style.
Help menu Provide the help using CELL.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.





Print command (File menu)

Use this command to print a document.      This command presents a Print dialog box, where you may 
specify the range of pages to be printed, the number of copies, the destination printer, and other printer 
setup options.

Shortcuts

Toolbar:
Keys: CTRL+P



Print dialog box

The following options allow you to specify how the document should be printed:

Printer
This is the active printer and printer connection.    Choose the Setup option to change the printer and 
printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:

All Prints the entire document.
Selection Prints the currently selected text.
Pages Prints the range of pages you specify in the From and To boxes.

Copies
Specify the number of copies you want to print for the above page range.

Collate Copies
Prints copies in page number order, instead of separated multiple copies of each page.

Print Quality
Select the quality of the printing.    Generally, lower quality printing takes less time to produce.



Print Progress Dialog

The Printing dialog box is shown during the time that <<YourApp>> is sending output to the printer.    The 
page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to display the active document as it would appear when printed.    When you choose 
this command, the main window will be replaced with a print preview window in which one or two pages 
will be displayed in their printed format.    The print preview toolbar offers you options to view either one or 
two pages at a time; move back and forth through the document; zoom in and out of pages; and initiate a 
print job.



Print Preview toolbar

The print preview toolbar offers you the following options:

Print
Bring up the print dialog box, to start a print job.

Next Page
Preview the next printed page.

Prev Page
Preview the previous printed page.

One Page / Two Page
Preview one or two printed pages at a time.

Zoom In
Take a closer look at the printed page.

Zoom Out
Take a larger look at the printed page.

Close
Return from print preview to the editing window.



Print Setup command (File menu)

Use this command to select a printer and a printer connection.    This command presents a Print Setup 
dialog box, where you specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.

Printer
Select the printer you want to use.    Choose the Default Printer; or choose the Specific Printer option 
and select one of the current installed printers shown in the box.    You install printers and configure 
ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to the type of 
printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Page Setup command (File menu)

<< Write application-specific help here. >>



Cell connect to Microsoft SQL server

With ODBC drivers, Cell can connect to remote database. 

Server: Windows NT 4.0, MS SQL Server 6.5

Client: Windows95, MS SQL Server 6.5 Client, Cell Control 3.1 Pack4

1 Configure client 

 SQL sever needn't configure before use.

2 Create ODBC data source

Open Control Panel, double Click 32bit ODBC icon (if you can't find it, please install ODBC drivers (you 

can find it in download page)), you get this dialog:



Click Add Button, select SQL server driver, then click Finish button.

You enter here, There are 3 parameters you should input: 1) Data Source name: make a name 

yourself; 2) Server: the computer name or IP address of the SQL server machine; 3) Database name: 

indicate a database in server (You may only query data in this database ). 



 

Click OK, then you create an ODBC data source named mssql65.

3 Use Cell Spreadsheet to make query

Open Cell Spreadsheet, find query database in File menu, like this:

Then select ODBC database type in this dialog, click Open,



the ODBC data source dialog will show, select mssql65 ( created just a moment ago), Click OK,



a SQL server login dialog will show, use the default id: sa, no password if you haven't set after install 

SQL server 6.5, Click OK,

then we come to end at last, see this, you can select table, or make query string yourself, Click Query 

you will get your data.



4 Use Cell Control

There are two methods to open an ODBC data source ( one can return tables list ):

BOOL DoOpenODBCDbase(LPCTSTR connectstr, VARIANT FAR* tables) 

BOOL DoOpenODBCDbaseVfp(LPCTSTR connectstr)

If you give a NULL or Empty connect string, the ODBC data source dialog will show, the dialog will not 

show if you connect string not NULL. for example, the connect string of the sample in Cell Spreadsheet 

is:

"DSN=mssql65;SERVER=nt4;UID=sa;PWD=;DATABASE=master"



Cell connect to Oracle

With ODBC drivers, Cell can connect to remote database. 

Server: Windows NT 4.0, Oracle 7.3.3 for NT ( computer name: nt4, Default network protocol:TCP/IP, 

Address: 100.100.100.1 )

Client: Windows95, Oracle 7.3.3 Client, Cell Control 3.1 Pack4 

1 Configure client 

 Configure Oracle Client after you install Oracle 7.3.3 Client for Windows95.

Run SQL Net easy Conifguration

Add Database Alias



Make a name for the new Database alias

Chose a network protocol

Input Host name and Database Instance (in most case, it's nmae it's 'ORCL' (default) ), 

Save new Database alias



Exit, now you can create ODBC data source .

2 Create ODBC data source

Open Control Panel, double Click 32bit ODBC icon (if you can't find it, please install ODBC drivers (you 

can find it in download page)), you get this dialog:

Click Add Button, select Oracle driver, then click Finish button.



You enter here, There are 2 parameters you should input: 1) Data Source name: make a name 

yourself; 2) SQL *Net Connect String: input the Database Alias which created a moment ago.

Click OK, then you create an ODBC data source named Oracle733.

3 Use Cell Spreadsheet to make query

Open Cell Spreadsheet, find query database in File menu, like this:

Then select ODBC database type in this dialog, click Open,

the ODBC data source dialog will show, select Oracle733 ( created just a moment ago), Click OK,



Oracle login dialog will show, use the default id: SYSTEM, password: MANAGER ( this is default 

password).

then we come to end at last, see this, you can select table, or make query string yourself, Click Query 

you will get your data.



4 Use Cell Control

There are two methods to open an ODBC data source ( one can return tables list ):

BOOL DoOpenODBCDbase(LPCTSTR connectstr, VARIANT FAR* tables) 

BOOL DoOpenODBCDbaseVfp(LPCTSTR connectstr)

If you give a NULL or Empty connect string, the ODBC data source dialog will show, the dialog will not 

show if you connect string not NULL. for example, the connect string of the sample in Cell Spreadsheet 

is:

"DSN=oracle73;DBQ=Oracledb1;UID=SYSTEM;PWD=MANAGER"



Cell connect to Sybase

With ODBC drivers, Cell can connect to remote database. 

Server: Windows NT 4.0, Sybase 11 ( computer name: nt4,    Default network protocol:TCP/IP, 

Address: 100.100.100.1 )

Client: Windows95, Sybase 11 Client, Cell Control 3.1 Pack4 or up ( note: Sybase 11 ODBC Drivers do 

not support snapshot recordset, please use Cell Control 3.1 Pack4 or up.) 

1 Configure client 

 You need to configure client after you install Sybase 11 Client.

 Run DsEdit in Sybase group, see this,

You enter this window, add a server object, 



enter this dialog, click Add Button, input server name, protocol, and address, port number,

when finished, you get this,



double click Server Address, input server address, like this:



Now you can test your work by ping server. 



Your connection to server succeed now! next step, run OC OS Config Utility in Sybase group,



Set SPX to NLNWLINK.



Then run SQL Advantage in Sybase group, see you can query data now.



2 Create ODBC data source

Open Control Panel, double Click 32bit ODBC icon (if you can't find it, please install ODBC drivers (you 

can find it in download page)), you get this dialog:

Click Add Button, select Sybase driver, then click Finish button.



You enter here, There are 3 parameters you should input: 1) Data Source name: make a name 

yourself; 2) Server: the computer name or IP address of the Sybase server machine; 3) Database 

name: indicate a database in server (You may only query data in this database ). 



Click OK, then you create an ODBC data source named Sybase11.

3 Use Cell Spreadsheet to make query

Open Cell Spreadsheet, find query database in File menu, like this:

Then select ODBC database type in this dialog, click Open,

the ODBC data source dialog will show, select Sybase11 ( created just a moment ago), Click OK,

Sybase login dialog will show, use the default id: sa, no password if you haven't set after install 

Sybase, Click OK,

then we come to end at last, see this, you can select table, or make query string yourself, Click Query 



you will get your data.

4 Use Cell Control

There are two methods to open an ODBC data source ( one can return tables list ):

BOOL DoOpenODBCDbase(LPCTSTR connectstr, VARIANT FAR* tables) 

BOOL DoOpenODBCDbaseVfp(LPCTSTR connectstr)

If you give a NULL or Empty connect string, the ODBC data source dialog will show, the dialog will not 

show if you connect string not NULL. for example, the connect string of the sample in Cell Spreadsheet 

is:

"DSN=sybase11;SRVR=nt4;DB=database1;UID=sa;PWD="




